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About This Document 
This document describes the functional and operational aspects of the Parameter Definition Editor. 
The document describes the functionality of the Parameter Definition Editor with respect to the 
creation/editing of the parameters and Configuration Forms for Field bus block types, Custom 
Data Block types, Custom Algorithm Block types, and Phase Block types. 
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Symbol Definitions 
The following table lists those symbols used in this document to denote certain conditions. 
 

Symbol Definition 
 

 
 

 
ATTENTION: Identifies information that requires special 
consideration.  

 

 

 
TIP: Identifies advice or hints for the user, often in terms of 
performing a task.  
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Conventions and Terms 

Conventions 
The following table summarizes the terms and type representation conventions used in 
this Guide. 

 
Term/Type 

Representation 
Meaning Example 

Click Click left mouse button once. 
(Assumes cursor is positioned on 
object or selection.) 

Click the Browse button.  

Double-click Click left mouse button twice in quick 
succession. (Assumes cursor is 
positioned on object or selection.) 

Double click the Station 
icon.  

Drag Press and hold left mouse button 
while dragging cursor to new screen 
location and then release the button.  
(Assumes cursor is positioned on 
object or selection to be moved.) 

Drag the PID function 
block onto the Control 
Drawing. 

Right-click Click right mouse button once. 
(Assumes cursor is positioned on 
object or selection.) 

Right-click the AND 
function block.  

<F1> Keys to be pressed are shown in 
angle brackets. 

Press <F1> to view the 
online Help.  

<Ctrl>+<C> Keys to be pressed together are 
shown with a plus sign.  

Press <Ctrl>+<C> to 
close the window.  

File->New Shows menu selection as menu name 
followed by menu selection 

Click File->New to start 
new drawing.  

>D:\setup.exe< Data to be keyed in at prompt or in an 
entry field. 

Key in this path location 
>D:\setup.exe<. 
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Terms 
Following are terms used in this document. 

• ACE Advanced Control Environment 

• CAB Custom Algorithm Block 

• CDB Custom Data Block 

• CDP Custom Data Parameter 

• EHI  Error Handling Infrastructure 

• ERDB Engineering Repository Database 

• FF  Foundation Field bus 

• FP  Formula Parameter 

• MDI Multiple Document Interface 

• PBT Phase Block Type 

• PDE Parameter Definition Editor 

• RCM Recipe Control Module. 

• RP  Report Parameter 

• SCM Sequential Control Module 
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Introduction 

Overview 
The Parameter Definition Editor (PDE) is a user interface to create and edit the block 
types using a grid interface that is similar to the Microsoft Excel grid. The PDE grid is 
configurable and can be customized specific to the block type being edited. The PDE 
provides user interfaces to edit the  

• Parameters attributes 

• Symbol attributes 

• Form layout  

All of the values above, Parameter attributes, Symbol attributes, and Form layout, are 
grouped into sections and shown in the PDE as separate grids. 

The PDE provides the following functionality: 

• Validating data type and range 

• Combo boxes to pick enumeration 

• Advanced grid to edit the bit string values 

• Advanced grid to edit arrayed parameters 

• Automatic form layout generation 

• Basic business rules to be applied in editing block types. 

• Manage views 

There are cases in which all of the parameter attributes need not be shown in the parameter grid. 
To switch the parameter attributes on and off in the grid, the PDE provides a Manage View 
feature. The view is a set of parameter attributes that are selected for showing in the parameter 
grid. Views can be defined specific to the user or specific to the block type. In the case of views 
specific to the block type (CAB/CDB types), the view information will be carried along with the 
block type definition. In the case of views specific to the user (Fieldbus block types), the views 
will be available only to the user who has defined the view and only on the system where the 
views were created. 

 

The PDE is launched within Control Builder as an MDI child window to edit Foundation 
Field bus block types and Custom Data Block types. The PDE is also launched within the 
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Visual Studio .NET IDE to edit the Custom Algorithm Block types. Both Control Builder 
and Visual Studio .NET will configure the PDE environment based on their requirement 
of editing block types. For example, the PDE will show the following: 

• Standard and Vendor parameters for Foundation field bus types. 

• Fixed, Custom, and Parameter References parameters for CAB types. 

• Custom parameters for CDB types. 

• Formula and Report parameters for Phase Block types. 

See the Custom Algorithm Block User’s Guide for more information on CAB/CDB usage. 

 



 

R300    Parameter Definition Editor Reference 15 
03/06 Honeywell  

Reviewing Container Types in PDE 

Overview 
There are three different container types supported by the Parameter Definition Editor 
within Control Builder: They are: 

• Fieldbus (FF) 

• Custom Data Block (CDB) 

• Custom Algorithm Block (CAB) 

• Phase Block 

General considerations 
Fieldbus 

The Fieldbus container of the PDE provides options to: 

• edit the Standard and Vendor parameter attributes, 

• define Form Layout, and 

• list all the Fieldbus Methods that are available in the block type. 

See Overview under Reviewing Fieldbus Block Type for more details. 

Custom Algorithm Block (CAB) 
The Custom Algorithm Block container of the PDE provides options to: 

• edit the Fixed, Custom (Value CDPs), and Parameter References parameter 
attributes, 

• define Form Layout, and 

• define symbol attributes of the CAB block type. 

See Overview under Reviewing Custom Algorithm Block for more details 
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Custom Data Block (CDB) 
The Custom Data Block container of the PDE provides options to: 

• create/edit the Custom Parameter (Value CDPs) attributes, 

• define Form Layout and 

• define Symbol Attributes of the block type. 

See Overview under Reviewing Custom Data Block for more details 

Phase Block 
The Phase Block container of the PDE provides options to: 

• create/edit the Formula Parameters  attributes, 

• create/edit the Report Parameters  attributes 

See Overview under Reviewing Phase Block for more details 
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Reviewing Fieldbus Block Type 

Overview 
The Fieldbus container of the PDE provides options to: 

• edit the Standard and Vendor parameter attributes, 

• define Form Layout, and 

• list all the Fieldbus Methods that are available in the block type. 

When a new block type is edited/created, a new MDI child window is created within 
Control Builder, containing the PDE user interface. 

Considerations 
• The parameter tab of the PDE container is configured to edit only the Standard and 

Vendor parameter attributes. 

• When a new FieldBus block type is edited/created, a new MDI child window will be 
created within Control Builder. 

• The PDE shows the following tabs to edit the FieldBus block type definition. 

− Standard Parameters tab 

− Vendor tab 

− Form Layout tab 

− Methods tab 

General editing functions 
Use the following links under Parameter Definition Editor Basics to access the Parameter 
Definition Editor’s general editing functions: 

• Considerations 

• Inserting, deleting, or appending rows 

• Using Copy and paste functions  

• Saving block definitions 

• Reviewing general block type functions 
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Reviewing Standard Parameters tab 
See the following to access more information about,  

• Overview under Accessing Standard Parameter Tab 

• Considerations under Accessing Standard Parameter Tab 

• Standard parameter tab attributes under Accessing Standard Parameter Tab 

Reviewing Vendor tab 
See the following to access more information about,  

• Overview under Accessing Vendor Tab 

• Vendor tab considerations under Accessing Vendor Tab 

• Vendor tab attributes under Accessing Vendor Tab 

Reviewing Form Layout tab 
See the following to access more information about,  

• Overview under Accessing Form Layout Tab 

• General considerations under Accessing Form Layout Tab 

• Form Layout tab attributes under Accessing Form Layout Tab 

• Form Layout tab selections under Accessing Form Layout Tab 

• and Automatic form layout under Parameter Definition Editor Basics. 

Reviewing Methods tab 
See the following to access more information about,  

• Overview under Accessing Methods Tab 

• Methods tab attributes under Accessing Methods Tab 
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Reviewing Custom Data Block 

Overview 
The Custom Data Block container of the PDE provides options to: 

• create/edit the Custom Parameter (Value CDPs) attributes, 

• define Form Layout and 

• define Symbol Attributes of the block type. 
 

 
ATTENTION 

When a new block type is edited/created, a new MDI child window is created 
within Control Builder, containing the PDE user interface. 

Considerations 
The PDE container is configured to edit only the Fixed and Custom parameter attributes. 

The “Value CDPs” parameter tab will allow you to create/delete/modify custom parameters. 

The defined custom parameters are assigned a pin value in the “Symbol Attributes” tab.  

The PDE shows the following tabs to edit the CDB block type definition. 

− Value CDP (Custom Data Parameter) tab 

− Form Layout tab 

− Symbol Attribute tab 
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General editing functions 
Use the following links under Parameter Definition Editor Basics to access the Parameter 
Definition Editor’s general editing functions: 

• Considerations 

• Inserting, deleting, or appending rows  

• Using copy and paste functions 

• Saving block definitions 

• Save As block definition 

• Reviewing general block type functions 

Reviewing Custom Parameters tab (Value CDPs) 
See the following to access more information about,  

• Overview under Accessing Custom Data Parameters tab 

• Considerations under Accessing Custom Data Parameters tab 

and 

− Reviewing min/max values of data types, 

− Reviewing valid parameter values and 

− Reviewing and Editing parameter attributes 

under Accessing Custom Data Parameters tab. 

Reviewing Form Layout tab 
See the following to access more information about,  

• Overview under Accessing Form Layout Tab 

• General considerations under Accessing Form Layout Tab 

• Form Layout tab attributes under Accessing Form Layout Tab 

• Form Layout tab selections under Accessing Form Layout Tab. 

• and Automatic form layout under Parameter Definition Editor Basics. 
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Reviewing Symbol Attributes tab 
See the following to access more information about,  

• Overview under Accessing Symbol Attributes Tab 

• Considerations under Accessing Symbol Attributes Tab 

• Symbol Attributes tab attributes under Accessing Symbol Attributes Tab 

• Configuring Pins under Accessing the Symbol Attributes Tab. 
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Reviewing Custom Algorithm Block 

Overview 
The Custom Algorithm Block container of the PDE provides options to: 

• edit the Fixed, Custom (Value CDPs), and Parameter References parameter  
  attributes, 

• define Form Layout, and 

• define symbol attributes of the CAB block type. 
 

 
ATTENTION 

The container for CAB is the Visual Studio .NET IDE editing environment. An 
instance of PDE will be created within the Visual Studio .NET IDE.. 

 
Considerations 

CAB uses the Visual Studio .NET Integrated Development Environment. (IDE) 

An instance of PDE will be created within the Visual Studio.NET IDE, and the following 
tabs are available to edit the block type definition: 

− Fixed parameters tab 

− Value CDP (Custom Data Parameter) tab 

− Parameter References tab 

− Form Layout tab 

− Symbol Attribute tab 

Only the default value of the fixed parameters can be edited in the “Fixed” parameters tab. 

The “Value CDPs” parameter tab and “Parameter references” tab will allow you to 
create/delete/modify custom and parameter reference parameters. 

User-defined custom parameters can be assigned a pin value in the “Symbol attributes” tab. 

The parameter will also be shown on the faceplate of the block. 
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General editing functions 
Use the following links under Parameter Definition Editor Basics to access the Parameter 
Definition Editor’s general editing functions: 

• Considerations 

• Inserting, deleting, or appending rows  

• Using copy and paste functions 

• Saving block definitions 

• Save As block definition 

• Reviewing general block type functions 

Reviewing Fixed Parameters tab 
See the following to access more information about,  

• Overview under Accessing fixed parameter tab 

• Considerations under Accessing fixed parameter tab 

• Fixed parameters tab attributes under Accessing fixed parameter tab 

Reviewing Custom Parameters tab (Value CDPs) 
See the following to access more information about,  

• Overview under Accessing Custom Data Parameters tab 

• Considerations under Accessing Customer Data Parameters tab 

• Custom parameter tab attributes under Accessing Customer Data Parameters tab 

and 

− Reviewing min/max values of data types, 

− Reviewing valid parameter values, and 

− Reviewing and Editing parameter attributes 

under Accessing Custom Data Parameters tab. 
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Reviewing Parameter References tab 
See the following to access more information about,  

• Overview under Accessing Parameter References tab. 

• Considerations under Accessing Parameter References tab. 

• Parameter References tab attributes under Accessing Parameter References tab. 

• Reviewing attribute default values 

• Reviewing valid parameter values under Accessing Parameter References tab 

Reviewing Form Layout tab 
See the following to access more information about,  

• Overview under Accessing Form Layout Tab. 

• Form Layout tab attributes under Accessing Form Layout Tab. 

• Form Layout tab selections under Accessing Form Layout Tab. 

• and Automatic form layout under Parameter Definition Editor Basics. 

Reviewing Symbol Attributes tab 
See the following to access more information about,  

• Overview under Accessing Symbol Attributes Tab 

• Considerations under Accessing Symbol Attributes Tab 

• Symbol Attributes tab attributes under Accessing Symbol Attributes Tab 

• Configuring Pins under Accessing the Symbol Attributes Tab. 
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Reviewing Phase Block 

Overview 
The Phase function block is a type block for use only in a Recipe Control Module 
(RCM).  

The Phase function block is used to initiate and monitor execution of the associated 
Equipment Module (SCM). The Phase function block can also be used to acquire the 
Equipment Module, such as SCM, for another Phase block. 

The Phase Block container of the PDE provides options to: 

• edit the Formula Parameter definitions and 

• edit the Report Parameter definitions. 

A Recipe Control Module contains Phases, Steps, Transitions and Synchronized blocks. 
A phase is based on Phase Block Type created with the PDE.  

The input values for the Phase Block type are defined as Formula Parameters. The output 
values for the Phase Block type are defined as Report Parameters. 

The Enabled flag defines if a parameter is used in a phase. 
 

 
ATTENTION 

When a new block type is edited/created, a new MDI child window is created 
within Control Builder, containing the PDE user interface. 

Considerations 
Phase Block does not support custom algorithms. 

 

 
TIP 

Optionally, a Phase Block can be connected to an Equipment Module, such 
as an SCM, where the input values (Formula parameters) are used and 
output values (Report parameters) are generated. 

 
An instance of PDE will be created within Control Builder, and the following tabs are 
available to edit the block type definition: 

− Formula parameters tab, see Accessing the Formula Parameters tab 

− Report References tab, see Accessing the Report Parameters tab 
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General editing functions 
Use the following links under Parameter Definition Editor Basics to access the Parameter 
Definition Editor’s general editing functions: 

• Considerations 

• Inserting, deleting, or appending rows  

• Using copy and paste functions 

• Saving block definitions 

• Save As block definition 

• Reviewing general block type functions 
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Reviewing Tab Types 

Overview 
The table below lists the block types supported by the Parameter Definition Editor. Each 
block type configuration form has multiple tabs to properly configure the block. The tabs 
associated with each block type are also listed in the table. 

 
Tab Name Fieldbus Custom 

Data Block 
Custom 

Algorithm 
Block 

Phase Block 

Standard Yes - - - 

Vendor Yes - - - 

Methods Yes - - - 

Form Layout Yes Yes Yes - 

Fixed (Parameter) - - Yes - 

Value CDP (Custom 
Parameter) 

- Yes Yes - 

Symbol Attribute - Yes Yes - 

Parameter References - - Yes - 

Formula Parameters - - - Yes 

Report Parameters - - - Yes 

 

Basic tab information 
The following table lists the location of information about the different tab types. 

 
If You Want . . .  Then see . . .  

Information about general editing 
functions 

Reviewing general editing functions 
under Parameter Definition Editor Basics. 

Information about the Standard tab Accessing the Standard Parameters tab 
under Reviewing Tab Types. 

Information about the Vendor tab Accessing the Vendor Parameters tab 
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If You Want . . .  Then see . . .  
under Reviewing Tab Types. 

Information about the Form Layout tab Accessing the Form Layout tab under 
Reviewing Tab Types. 

Information about the Methods tab Accessing the Methods tab under 
Reviewing Tab Types. 

Information about the Value CDPs tab Accessing Custom Parameters tab 
(Value CDPs) under Reviewing Tab 
Types. 

Information about the Fixed Parameters 
tab 

Accessing the fixed parameters tab 
(Fixed)  under Reviewing Tab Types. 

Information about the Parameters 
References tab 

Accessing the Parameter References tab 
under Reviewing Tab Types. 

Information about the Symbol Attributes 
tab 

Accessing the Symbol Attributes tab 
under Reviewing Tab Types. 

Information about the Formula 
Parameters tab 

Accessing the Formula Parameters tab 
under Reviewing Tab Types. 

Information about the Report Parameters 
tab 

Accessing the Report Parameters tab 
under Reviewing Tab Types. 

 

Accessing the Standard Parameters tab 
Overview 

The standard parameters tab is located on the following block type: 

• Fieldbus 

The Standard Parameters tab lists all the standard parameters for the selected FieldBus 
device block type. The Standard tab parameters are listed in a spreadsheet format for 
editing. See the considerations below for limitations on parameter editing. 

Considerations 
• The following parameter attributes are read only; 

− Parameter Name 
− Parameter Index 
− First Dimension Array Size 
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− Data Type 
− Size 

• You cannot add a new parameter to or delete an existing parameter from this tab. 

• The Minimum value and Minimum value reference parameter attributes are mutually exclusive. 

• The Maximum value and Maximum value reference parameter attributes are 
mutually exclusive. 

• The Unit and Unit reference parameter attributes are mutually exclusive. 

• You can only edit Minimum and Maximum values and references if their data type is 
integer or float. Otherwise, these attributes will be read only.  

• You can only edit a Default value if it does not have an Access Lock attribute of 
View Only and a data type of STRUCT.  

• The default value is validated for the limits of the minimum and maximum values.  

• You cannot edit the permission attribute for members that belong to the STRUCT 
data type parameters and the MODE parameter.  

• You can use the Configure PDE Views function to turn parameter attributes view On 
or Off in the tab. 

• The parameter description, parameter helps string and default value attributes are the 
only case sensitive attributes. 

• Columns can be sorted by double-clicking on the column header. The sorting will 
toggle between ascending and descending order. 

• This tab will not be shown if no standard parameter exists in the block type. 

Standard parameter tab attributes 
The following table lists the parameter attributes that can be shown on this tab. 

 
Parameter Attribute Description 

Parameter Name The name of the parameter (read-only). 

Parameter Description The short description of the parameter restricted 
to 255 characters. This description will be used in 
the Configure Parameters dialog in Control 
Builder. 
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Parameter Index The index of the parameter (read-only). 

First Dimension Array Size The first dimension of the array, if the parameter is 
to be arrayed (read-only). 

First Dimension Lower bound The lower bound of the first array dimension 
(read-only). 

Configuration Load Indicates whether the parameter value is to be 
loaded or not when the block is loaded to the 
device. 

Access Lock Defines what kind of users can write to the 
parameter. 

Data Type The data type of the parameter (read-only). 

Default Value The default value of the parameter. 

Minimum Value The minimum value of the parameter. This 
attribute is applicable only to the integer and float 
data types. 

Minimum Value Reference The parameter within the same block type that 
holds the minimum value for the parameter. 

Maximum Value The maximum value of the parameter. This 
attribute is applicable only to the integer and float 
data types. 

Maximum Value Reference The parameter within the same block type that 
holds the maximum value for the parameter. 

Size The size of the default value of the string data 
type. This attribute is applicable for the string, 
struct, and bit string data types (read-only). 

Permission Permission for the field bus parameter 

Unit The unit for the parameter 

Unit Reference The parameter within the same block type that 
holds the value of unit for the parameter 

Accessing the Vendor Parameters tab 
Overview 

The Vendor Parameters tab is located on the following block type: 
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Fieldbus 

The vendor tab lists all the manufacturer specific parameters for the selected FieldBus 
device block type. The functionality of this tab is identical to the Standard Parameters 
tab. 

Vendor tab attributes 
The Vendor tab attributes are the same as the Standard tab attributes. See Standard 
parameter tab attributes under Accessing the Standard Parameters tab for a list of the 
parameter attributes. 

Vendor tab considerations 
The considerations that you should be aware of while editing the Vendor tab are the same 
as those for the Standard tab. Refer to Considerations under Accessing the Standard 
Parameters tab. 
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Accessing the Form Layout tab 
Overview 

The Form Layout tab is located on the following block types: 

Fieldbus 

Custom Data Block 

Custom Algorithm Block 

The Form Layout tab lets you define the layout of the parameters that appear on the 
Configuration Form for an instance of the associated block in the Project tab of Control Builder. 

General considerations 
• The initial form layout is defined by the organization of the parameters in the block 

type residing in the Library tab of Control Builder. 

• You can insert, delete and rename tabs in the Form Layout tab. 

• Tabs can be re-arranged using drag and drop. 

• You can add and delete parameters from the tabs in the Form Layout tab. 

• The Main, Alarms, and Source tabs (CAB) and the Alarm tab (Fieldbus) are read 
only and cannot be edited. This means you cannot rename the tabs nor insert a tab 
before or in between them. 

• You can only use a parameter once across all the tabs defined in the Form Layout tab. 

• A shaded cell is not available for edit. 

• Parameters can be defined under grid using the grid functionality CAB and CDB). 

• A drop-down menu can also be invoked using the right click on the tab. In this case 
the selected option will be applied to the tab on which the right click was done. 
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Fieldbus Form layout considerations 
• Only parameters from the Standard and Vendor tabs can be added to the Form 

Layout tab. Custom tabs can also be added to the Form Layout tab. 

• The MODE AXVALUEONLY parameter group cannot be deleted from the form 
layout and hence it will be shown in gray background. 

CDB form layout considerations 

• The “Value CDPs” tab on the Form Layout is the tab where all the Custom 
parameters defined in the “Value CDPs” main tab are shown. 

• The order of the parameters in the “Value CDPs” tab on the form layout will be the 
same order as defined in the “Value CDPs” main tab. This layout is automatically 
generated when the new CDP is defined/deleted in the “Value CDPs” main tab. This 
is known as Automatic Form layout generation. 

• Any change in the order of the definition of the CDPs in the “Value CDPs” main tab 
will be reflected in the Value CDPs tab on the Form Layout. 
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CAB form layout considerations 
• The “Value CDPs” is the tab where all the Custom parameters defined in the “Value 

CDPs” main tab will be shown. 

• The order of the parameters in the “Value CDPs” tab on the form layout will be the 
same order as defined in the “Value CDPs” main tab. This layout is automatically 
generated when the new CDP is defined/deleted in the “Value CDPs” main tab. This 
is known as Automatic Form layout generation. 

• Any change in the order of the definition of the CDPs in the “Value CDPs” main tab 
will be reflected in the Value CDPs tab on the Form Layout. 

• The “Parameter References” tab is the tab where all the parameter references defined 
in the “Parameter References” main tab will be shown. 

• The order of the parameters in the “Parameter References” tab on the Form Layout 
will be the same order as defined in the “Parameter References” main tab. This layout 
is automatically generated when the new parameter reference is defined/deleted in the 
“Parameter References” main tab. This is Automatic Form layout generation. 

• Any change in the order of the definition of the Parameter References in the 
“Parameter References” main tab will be reflected in the “Parameter References” tab 
on the Form Layout. 

• Rows can be inserted using INS key and can be deleted using DEL key. 
Alternatively Right click menu is also available for inserting and deleting the row. 
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CAB/CDB blocks 

The layout and content of the Value CDP and Parameter References tab can be modified. 
Custom tabs can also be added with their own content and layout. 

In the next figure, custom parameters were added to the Value CDPs tab. 
 

 
ATTENTION 

Although these parameters are automatically placed on the Value CDPs 
Form tab and they could be left on that form, they have all been moved to a 
custom tab. All of these values will be used later on that custom tab of the 
Form Layout. 

 

Value CDPs Tab with Custom Parameters Added 
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New Tab (OPC_14) Created with Value CDPs Parameters Added to This Tab 
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Properties Form Showing Custom Tab 

 
 

 
TIP 

AC_P1, AC_P2, and AC_P3 have been configured as 5 position arrays. 
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Form Layout tab attributes 
The following table lists the parameter attributes that can be shown on this tab. 

 
Layout Attribute Description 

Left field name Define parameters you want to be 
included on the left-hand side of the 
Configuration Form associated with the 
block in the Project tab of Control Builder. 

Right Field name Define parameters you want to be 
included on the right-hand side of the 
Configuration Form associated with the 
block in the Project tab of Control Builder. 

Form Layout tab selections 
The Form layout tab has several standard second level tabs that can be accessed from the 
top of the Form Layout. These second level tabs are described in the next table. 

 
Tab Name Used with 

Block Type 
Purpose 

Process Fieldbus These are the parameters of most 
interest to the user observing the 
operation of the block.  They include 
the mode (actual, and target, if 
different), and may include various 
setpoint values and statuses, input 
values and statuses, output values 
and statuses, readback values and 
statuses, etc.  For control-related 
blocks this tab includes back-
calculation input and outputs and 
statuses, feed-forward input and 
status, tracking inputs and statuses, 
and remote output inputs and outputs 
and statuses. Statuses are shown by 
exception (blank if normal). 
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Alarm Fieldbus These are the FF standard alarm 
parameters presented in a matrix form.  
The rows are the applicable alarm 
conditions.  The columns show alarm 
state, priority, limit, disable, time of last 
change of state, etc. 

This tab is Read Only. 

Alarm2 Fieldbus This tab presents manufacturer-
specific parameters, if any that apply 
to alarming. The tab will not appear if 
there are no applicable parameters. 

Maintenance Fieldbus These are the parameters associated 
with maintenance of the physical 
device.  BLOCK_ERR and 
XD_ERROR indications as well as 
bypass, calibration records, and 
simulation controls appear here. 

Ranges Fieldbus Range limits and engineering units 
appear on this tab. Limits, including 
setpoint limits and output limits appear 
here. 

Tune Fieldbus Control, status, input/output options, 
tuning constants, fault-state and shed 
options appear on this tab. 

Other, Other2 Fieldbus Miscellaneous and manufacturer-
specific parameters that are not 
otherwise designated to appear on any 
other tab default to this tab. PDE 
allows re-assignment of the tab to 
which manufacturer-specific 
parameters are assigned. If this tab 
would have a large number of 
parameters, additional tabs named 
OTHER2, OTHER3, etc. are created 
to limit the amount of scrolling needed.  
No OTHER tabs appear if there are no 
applicable parameters. 

Main CAB/CDB Displays Fixed Definition Parameters 
that apply for CAB and CDB. 
This tab is Read Only 



Reviewing Tab Types 
Accessing the Form Layout tab 

42   Parameter Definition Editor Reference  R300 
 Honeywell 03/06 

Value CDPs CAB/CDB This tab contains the Custom Data 
Parameters defined for CAB and CDB 
as a default. It can be modified with 
the PDE Form Layout to include 
Parameter References or Fixed 
Definition Parameters that don’t 
appear on the Main tab. 

Parameter References CAB This tab contains the Parameter 
References that are defined for CAB 
as a default. It can be modified with 
PDE Form Layout to include 
Parameter References or Fixed 
Definition Parameters that don’t 
appear on the Main tab. 

Source CAB Contains the SRCDATA parameter. 
The SRCDATA parameter allows the 
user to view the main source file for 
the selected CAB type. In the case of 
instances, it allows a user to view the 
source to see what the CAB program 
algorithm is without opening the CAB 
type in Edit or View only mode. In the 
case of Operators on a station, this 
gives them access to view the 
program because they cannot open 
the CAB type in edit or View only from 
a Station. 
This tab is Read Only 



Reviewing Tab Types 
Accessing the Form Layout tab 

R300   Parameter Definition Editor Reference 43 
03/06 Honeywell 

Alarms CAB The alarms tab provides the engineer 
with the ability to change the priority 
and severity of each of the four CAB 
alarm types for a CAB instance. The 
possible priorities are, 

• NONE 

• JOURNAL 

• LOW 

• HIGH 

• URGENT 

The severities range from 0 to 15. 

An alarm will be triggered (when the 
priority is LOW, MEDIUM, or HIGH) for 
parameter reference read errors, 
parameter reference write errors, CAB 
termination (caused by block overrun 
or user abort), and CAB exceptions. 

A NONE priority will not trigger an 
alarm and a JOURNAL priority will 
trigger a journal event. 

This tab is Read Only 
 
Form Layout tab functions 

The following are additional functions that can be performed using the Form layout tab. 
These functions can be found under Parameter Definition Editor Basics. 

• Reviewing the group box 

• Reviewing the grid 

• Inserting, deleting, renaming, and appending tabs 
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Accessing the Methods tab 
Overview 

The Methods tab is located on the following block type: 

Fieldbus 

From the Methods tab, you can view the entire vendor embedded methods associated 
with the selected FieldBus device block in a read-only Name and Description format. 

 

 
TIP 

This tab will not be shown if the block type does not have any methods. 
 
Methods tab attributes 

The following table lists the parameter attributes that can be shown on this tab. 
 

Layout Attribute Description 

Method name Lists the entire vendor embedded 
methods for a given device. 

Method description Description of listed method. 
 

Accessing the fixed parameters tab (Fixed) 
Overview 

The fixed parameters tab is located on the following block types: 

Custom Algorithm Block 

The fixed parameters tab lists all the fixed parameters of the block type. This tab is used 
to edit the default value of the parameters. All other parameter attributes are read-only.  
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Considerations 
• All the fixed parameters will be shown in the tab.  

• Only the default value attribute is editable 

• Editing of default value is based on the data type of the parameter attribute 

• New parameters cannot be added in this tab 

• Existing parameters cannot be deleted from this tab 

• All predefined fixed parameters will start with the characters X_ 
 

 
ATTENTION 

If a new fixed parameter is created, do not start the name of this new 
parameter with the characters X_. X_ fixed parameters are predefined 
parameters. 

This will prevent parameter name duplication of block parameters that have 
already been predefined by Honeywell. 

 

Predefined fixed parameters 
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Fixed parameters tab attributes 
The following table lists the parameter attributes that can be shown on this tab. 

 
Parameter Attribute Description 

Parameter Name The name of the parameter 

Parameter Description The short description of the parameter 

Data Type The data type of the parameter 

Default Value The default value of the parameter. Only 
this attribute is editable. 
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Accessing Custom Parameters tab (Value CDPs) 
Overview 

The custom parameter tab (identified with the tab label, Value CDPs) is located on the 
following block types: 

Custom Data Block, and 

Custom Algorithm Block 

The “Value CDPs” tab is used to define the custom parameters. New custom parameters 
can be added and deleted from this tab. Designated parameter attributes can be edited. 
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Considerations 
• All the Custom parameters are shown in the tab 

• New parameters can be added 

• Existing parameters can be deleted subject to the rules defined in the section 
Reviewing and Editing parameter attributes under Accessing custom parameters tab 
(Value CDPs). 

• Editing of the default value is based on the data type of the parameters subject to the 
rules defined in the section Reviewing and Editing parameter attributes under 
Accessing custom parameters tab (Value CDPs). 

• Access lock, Configuration load, and Data type can be selected using the combo box. 

• Manage View is supported in this tab to switch ON/OFF the parameter attributes that 
are to be shown in the tab. 

• The parameters defined in this tab are used to generate an automatic form layout in 
the 2nd tab (Value CDPs) of the form layout. 

• The parameter description, parameter help string, and default value attributes are the 
only case sensitive attributes. 

• Cut/Copy/Paste Parameters feature is available in this tab. 
 

 
ATTENTION 

If a new custom parameter is created, do not start the name of this new 
parameter with the characters X_. X_ custom parameters are predefined 
parameters. 
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Custom parameter tab attributes 
• The Value CDPs tab lists the parameter attributes shown below. Some parameter 

attributes are exposed by default. The other parameter attributes can be made 
visible/invisible on the tab using Launching Configure PDE views dialog under 
Reviewing PDE views. 

 
Parameter Attribute Description Exposed by Default 

Parameter Name The name of the parameter Yes 

Parameter Description The short description of the 
parameter restricted to 255 
characters. This description 
will be used in the Configure 
Parameters dialog in CB. 

Yes 

First Dimension Array 
Size 

The first dimension of the 
array if the parameter is to be 
arrayed 

Yes 

Second Dimension Array 
Size 

The second dimension of the 
arrayed parameter 

No 

First Dimension Lower 
bound 

The lower bound of the first 
array dimension 

No 

Second Dimension Lower 
bound 

The lower bound of the 
second array dimension 

No 

Configuration Load The attribute indicating 
whether the parameter value 
is to be loaded to ACE 

Yes 

Access Lock Attribute describing what kind 
of users can write to the 
parameter 

Yes 

Data Type The data type of the 
parameter 

Yes 

Default Value The default value of the 
parameter 

Yes 

Minimum Value The minimum value of the 
parameter. This attribute is 
applicable only to the integer 
and float data types 

No 
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Maximum Value The maximum value of the 
parameter. This attribute is 
applicable only to the integer 
and float data types 

No 

Size The size of the default value 
of the string data type.  This 
attribute is applicable only to 
the string data type. 

No 

Parameter Help String The long description of the 
parameter that will be used in 
the Knowledge Builder to 
show the help on the 
parameter. 

No 

 
Reviewing min/max values of data types 

The minimum and maximum values of the different data types are listed below. 
 

Data type Minimum Value Maximum Value 

INT32 –2147483648 2147483647 

FLOAT64 2.2250738585072014e-308 1.7976931348623158e+308 

STRING --- 255 Characters 
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Reviewing valid parameter values 
The list of valid values for the parameter attribute is listed below. 

 
Parameter Attribute Valid values 

Parameter Name The first character of the parameter name should be 
an alpha character. 

Only “_” character is allowed in the parameter name 
other than alphanumeric characters 

The maximum length of the parameter name is 12 
characters  

The parameter name will always be converted to 
upper case letters. 

Parameter Description Any character with maximum length of 255 

First Dimension Array Size >= 0 and <= 10,000 

0 – means parameter is not arrayed 

NOTE: The product of the First Dimension and the 
Second Dimension can not exceed 10,000. 
Therefore, if the First Dimension Array Size = 5000, 
then the maximum value for the Second Dimension 
Array Size would be 2 , ie (2 X 5000 = 10,000). 

Second Dimension Array Size >= 0 and <= 10,000 

0 – means second dimension is not specified 

The First Dimension Array Size should be specified 
to enter the second dimension array size. 

NOTE: The product of the First Dimension and the 
Second Dimension can not exceed 10,000. 
Therefore, if the First Dimension Array Size = 5000, 
then the maximum value for the Second Dimension 
Array Size would be 2 , ie (2 X 5000 = 10,000). 

First Dimension Lower bound Positive/Negative INT16 value 

First dimension array size should be specified to 
enter this attribute 

Second Dimension Lower 
bound 

Positive/Negative INT16 value 
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Second dimension array size should be specified to 
enter this attribute 

Configuration Load LOAD – Load the parameter 

NOLOAD – Do not load the parameter 

Access Lock APPDEVONLY 
ENGINEER 
OPERATOR 
PROGRAM 
SUPERVISOR 

Data Type BOOLEAN 
DELTATIME 
FLOAT64 
INT32 
STRING 
TIME 
TIMEOFDAY 

Default Value Specific to data type attribute 

Minimum Value Specific to data type attribute 

Maximum Value Specific to data type attribute 

Size >= 0 

Parameter Help String No limit 
 
Reviewing and Editing parameter attributes 

Default 
 

 
ATTENTION 

The Default Value attribute cannot be edited if the Configuration Load 
attribute is “NOLOAD” and the default value will be reset to nothing. 

Setting the “Access Lock” attribute to “ViewOnly” sets the “Configuration Load” to 
“NOLOAD”. This makes the “Default Value” attribute read-only. The default value 
resets to nothing. 
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The attribute default values of the parameters are listed in the table below. 
 

Parameter Attribute Attribute Default Value 

Configuration load NO LOAD 

First dimension array size 0 

Second dimension array size 0 

First dimension array lower bound 0 

Second dimension array lower bound 0 

Default Size for the string data type 32 
 

Custom parameter restrictions 

Changing some of the attributes of a custom parameter will not allow saving the block 
with the same name if instances of the block with custom parameters exists. Below is the 
list of such scenarios. 

− Changing the Data Type of the custom parameter 

− Deleting the custom parameter from the block 

− Renaming any custom parameter of the block 

− Changing a CDP from a scalar to an array or vice versa. 

When such scenarios occur then the Save As block definition function will be invoked. 
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Using cut/copy/paste for custom parameters 

The custom parameters tab will not show all the attributes of the parameters. There are 
some attributes, which are internally managed. When using the Manage views feature, 
the attributes can also be hidden. In such scenarios the need arises to copy the whole 
parameter definition irrespective of whether attribute is internally managed or hidden 
through views. The cut/copy/paste parameters features will allow copying the whole 
parameter definition and pasting the definition as a new parameter. This feature will also 
work across the PDE, meaning in one instance of the PDE the parameters can be copied 
and pasted in another instance of the PDE. 

 
If you want to ….. Then see….. 

copy parameters Copy Parameters under Reviewing 
general parameter functions. 

paste parameters Paste Parameters under Reviewing 
general parameter functions. 

cut parameters Cut Parameters under Reviewing general 
parameter functions. 
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Accessing the Symbol Attributes tab 
Overview 

The symbol attributes tab is located on the following block types: 

Custom Data Block, and 

Custom Algorithm Block 

The symbol attributes tab is used to associate a pin number with the parameter for a 
block type. The parameter will also be shown on the faceplate of the block. The 
parameter, which has a valid pin exposure permission, can be used to assign the block 
pin. The individual elements of an arrayed parameter can be used to assign a block pin. 

 
 

The tab lists the pins shown below for which the parameter is assigned. 

• Input Top Pin 

• Input Left Pin 

• Output Bottom Pin 

• Output Right Pin 

• Config face 

• Monitor face 
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Considerations 
• The parameter to be exposed will be defined in the column “Parameter name”. 

• Any parameter that has the pin exposure permission set can be configured on the 
symbol attributes. 

• NOLOAD parameter cannot be configured on Configuration faceplate. 

• Parameter name can be picked by clicking on the button provided in the right of the 
Parameter name cell. This will show the dialog listed under Accessing the Symbol 
Attributes tab. 

• For arrayed parameters, individual array indices can be used to define the symbol 
attribute. The arrayed parameter should be defined with the syntax <parameter 
name>[[first dimension index], [second dimension]] 

• For arrayed parameters, the whole array transfer can be specified on the symbol 
attribute with the syntax <parameter name>[.<space>] 

• A pin number for a parameter can be assigned by keying in the pin number in the 
provided pin columns 

• If a pin is not to be exposed for parameters, the relevant cell in the grid should be left blank. 

• The pin values in the column are unique and a positive number starting from 0. 

• The top pin and the left pin are mutually exclusive. 

• The bottom pin and the right pin are mutually exclusive. 

• Copy/Paste of symbol attribute information can be done using the right click menu 
and accelerator keys Ctrl+C and Ctrl+V respectively. 

• Columns can be sorted by double-clicking on the column header, toggling between 
ascending and descending sort order. 
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Symbol Attributes tab attributes 
The following table lists the parameter attributes that can be shown on this tab. 

 
Parameter Attribute Description 

Parameter Name The name of the parameter 

Input Top Pin The location to define the top pin for a 
block. 

Input Left Pin The location to define the left pin for a 
block. 

Output Bottom Pin The location to define the bottom pin for 
a block. 

Output Right Pin The location to define the right pin for a 
block. 

Config Face The location to define the configuration 
face for a block. 

Monitor Face The location to define the monitor face 
for a block. 

 
Configuring Pins 
 

 
ATTENTION 

You will have to delete and re-add instances in a Control Module if you make 
changes in the PDE Symbol Attributes tab if any instances exist on the 
configuration/monitor side. 
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To configure a parameter for an input, the pin order should be entered in Input Top pin or 
the Input Left pin column. The input pins are shown as below in Control Builder. 

Parameter configured in PDE as Input Left pin 

 

 

Parameter configured as Input Left pin shown in Control Builder 

 

 

Parameter configured in PDE as Input Top pin 

 

 

Parameter configured as Input Top pin shown in Control Builder 
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To configure the parameter for an output, the pin order should be entered in the Output 
Bottom pin or the Output Right pin column. The output pins are shown as below in 
Control Builder. 

Parameter configured in PDE as Output Right pin 

 

 

Parameter configured as Output Right pin shown in Control Builder 

 

 

Parameter configured in PDE as Output Bottom pin 

 

 

Parameter configured as Output Bottom pin shown in Control Builder 

 

To configure the pin on the configuration faceplate, the pin order should be entered in the 
Config face column. The parameter value will be shown on the block in configuration 
side only 
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Parameter configured in PDE to be shown on Config face 

 

Parameter shown on faceplate in Control Builder 

 

To configure the pin on the monitor faceplate the pin order should be entered in the Monitor 
face column. The parameter value will be shown on the block in monitor side only. 

 

Reviewing parameter picker 
The Parameter Picker dialog provides an option to search for a parameter to configure the 
symbol attribute. The dialog lists all the parameters that have valid pin exposure 
permissions with an edit box for searching the parameter. 
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Considerations 

• The list of parameters defined in the block that has a valid pin exposure permission 
set will be listed in the parameters list. 

• If the parameter is arrayed then the parameter name will be shown in the following 
formats 

− <parameter name>[<space>] to pin for whole array transfer. 

− <parameter name>[N] for a single dimension array where N is the dimension of 
single dimension array to be entered. 

− <parameter name>[N, M] for a 2-dimension array where N is the first dimension 
of array and M is the second dimension of array. 

• Typing the parameter in the parameter edit box will select the nearest matching 
parameter in the parameter list 

• If an individual array element of a parameter is to be pinned, then the arrayed 
parameter should be selected and the valid index should be specified in the Parameter 
Name column of the “Symbol Attributes” tab. 

• Parameters can be selected by double clicking on the parameter name. The index 
must be specified for arrayed parameters. 
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Accessing the Parameter References tab 
Overview 

The parameter references tab is located on the following block type: 

Custom Algorithm Block 

Considerations 
The parameter references allow defining the parameter alias. New parameter references 
can be added defining the data type and the data flow of the parameter. 

• All the Parameter references are shown in the tab 

• New parameters can be added. 

• Existing parameters can be deleted. 

• The parameters defined in this tab are used to generate an automatic form layout in 
the 3rd tab (Parameter References) of the form layout. 

• The parameter description attribute is the only attribute that is case sensitive. 

• Cut/Copy/Paste Parameters feature is available in this tab. 
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Parameter References tab attributes 
The tab will list the parameter attributes shown below. 

 
Parameter Attribute Description 

Parameter Name The name of the reference parameter. 

Parameter Description The short description of the parameter 
attribute is restricted to 255 characters. 
This description will be used in the 
Configure Parameters dialog in Control 
Builder. 

Reference data type The data type of the reference 
parameter. 

Data flow The attribute specifying the reference is 
being used for input, output or both. 

Dynamic Reference Configurable for either static referencing, 
or for Dynamic Referencing. 

Dynamic Referencing allows the user to 
change the target for the reference “on 
the fly”, even though the instance is 
loaded and executing. 

For more information on Dynamic 
Referencing, see the Custom Algorithm 
Block and Custom Data Block User’s 
Guide, Dynamic re-referencing of 
parameter references. 

 
Reviewing attribute default values 

The attribute default values of the parameter attributes for the Parameter Reference Tab 
are listed in the table below. 

 
Parameter Attribute Attribute Default Value 

Data Flow INPUT 

Dynamic Reference Cleared 
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Reviewing valid parameter values 
The lists of valid values for the parameter attributes are listed below. 

 
Parameter Attribute Valid values 

Parameter Name The first character of the parameter name 
should be alphabetic. 

Only “_” character is allowed in the 
parameter name other than alphanumeric 
characters. 

The maximum length for the parameter 
name is 32 characters. 

The parameter name will be always 
converted to upper case letters. 

Parameter Description Any character with maximum length of 
255. 

Data Type BOOLEAN 
DELTATIME 
FLOAT64 
INT32 
STRING 
TIME 
TIMEOFDAY 

Data flow INPUT – Only reading of Data is allowed 

OUTPUT – Only writing of data is allowed 

IN/OUT – Data can be either read or write. 

Dynamic Reference Checked or Cleared 
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Accessing the Formula Parameters tab 
Overview 

The formula parameters tab is located on the following block type: 

Phase Block 

Considerations 
The Formula Parameter tab contains all the user defined formula parameters for the 
Phase block. 

• All the Formula Parameters are shown in the tab 

• New parameters can be added. 

• Existing parameters can be deleted. 
 

 
TIP 

If a parameter is deleted, the phase block type can not be saved, rather, a 
new phase block type must be created. 

 
• The parameter description attribute is the only attribute that is case sensitive. 

• Cut/Copy/Paste Parameters feature is available in this tab. 
 

 
TIP 

The maximum number of Formula plus Report parameters can not exceed 
50. 
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Formula Parameters tab attributes 
The tab will list the parameter attributes shown below. 

 
Parameter Attribute Description 

Parameter Name Unique among all parameter names of the phase block 

Can be only modified in the Parameter Definition Editor 
(PDE). 

Parameter description This text is shown in the phase block form when the 
parameter values are edited and in the RCM detail displays 
when the parameter is used for operators. The text can 
contain localized characters, such as Kanji. 

Can be only modified in the Parameter Definition Editor 
(PDE). 

Data type Choices are: 

BOOLEAN 
FLOAT64 
INT32 
STRING 

Can be only modified in the Parameter Definition Editor 
(PDE). 

Default value  

Minimum value Specifies the Minimum value  

Range depends on the selected data type. For floating 
point numbers, the limit values can be NaN. For integers, 
the smallest possible number is not available as a limit (it is 
used as invalid number for integers.) 

NOTE: The usage of NaN implies that the limit is not used. 

Maximum value Specifies the Maximum value  

Range depends on the selected data type. For floating 
point numbers, the limit values can be NaN. 

NOTE: The usage of NaN implies that the limit is not used. 
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Use value reference Checked – use the run-time value retrieved from the source 
defined in the phase block form.  

Unchecked – use the default value or the value edited in 
phase block form or RCM detail display 

Enabled Checked – parameter is used in the phase block instance 

Unchecked - parameter is not used in the phase block 
instance and not shown in the RCM detail display 

Size Defines the maximum length of string value.  

Default = 32 

Engineering Units Text defining the engineering units associated with the 
parameter 

Scalable Used only for formula parameters 

Checked – the value is scaled with the ratio between 
current batch size and the default batch size when the 
value is downloaded into the target parameter.  

Unchecked – no scaling is done in the value download 
operation 

Access lock Used only for formula parameters 

Based on the AccessLocks enumeration type values: 
Program, Engineer, Supervisor, Operator, AppDevOnly 
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Accessing the Report Parameters tab 
Overview 

The report parameters tab is located on the following block type: 

Phase Block 

Considerations 
Report Parameter tab contains all the user defined report parameters for the Phase block. 

• All the Report Parameters are shown in the tab 

• New parameters can be added. 

• Existing parameters can be deleted. 
 

 
TIP 

If a parameter is deleted, the phase block type can not be saved, rather, a 
new phase block type must be created. 

 
• The parameter description attribute is the only attribute that is case sensitive. 

• Cut/Copy/Paste Parameters feature is available in this tab. 

• There is no hard limit on the maximum number of report parameters that can be 
configured in a Phase Block, although 50 parameters is the recommended maximum.  

 

 
TIP 

The maximum number of Formula plus Report parameters can not exceed 
50. 

 
Report Parameters tab attributes 

The tab will list the parameter attributes shown below. 
 

Parameter Attribute Description 
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Parameter Attribute Description 

Parameter Name Unique among all parameter names of the phase block 

Can be only modified in the Parameter Definition Editor 
(PDE). 

Parameter description This text is shown in the phase block form when the 
parameter values are edited and in the RCM detail displays 
when the parameter is used for operators. The text can 
contain localized characters, such as Kanji. 

Can be only modified in the Parameter Definition Editor 
(PDE). 

Data type Choices are: 

BOOLEAN 
FLOAT64 
INT32 
STRING 

Can be only modified in the Parameter Definition Editor 
(PDE). 

Default value  

Minimum value Specifies the Minimum value  

Range depends on the selected data type. For floating point 
numbers, the limit values can be NaN. For integers, the 
smallest possible number is not available as a limit (it is 
used as invalid number for integers.) 

NOTE: The usage of NaN implies that the limit is not used. 

Maximum value Specifies the Maximum value  

Range depends on the selected data type. For floating point 
numbers, the limit values can be NaN. 

NOTE: The usage of NaN implies that the limit is not used. 

Enabled Checked – parameter is used in the phase block instance 

Unchecked - parameter is not used in the phase block 
instance and not shown in the RCM detail display 
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Parameter Attribute Description 

Size Defines the maximum length of string value.  

Default = 32 

Engineering Units Text defining the engineering units associated with the 
parameter 

Trend Used only for report parameters. 

Checked – value will be trended 

Unchecked – value will not be trended 
 



 

R300    Parameter Definition Editor Reference 71 
03/06 Honeywell  

Parameter Definition Editor Basics 

Reviewing general editing functions 
Considerations 

• You are familiar with interacting with Windows programs, such as Microsoft Excel. 

• Read only cells are shaded and are unavailable for editing. 

• You must have Engineering access level or higher to make edits. 
 

If You Want To . . .  Then . . . 

Resize a column Move cursor over column vertical dividing 
line so cursor changes shape and click 
and drag cursor left or right to decrease 
or increase the column width.  

Navigate between cells You can use many of the keyboard 
shortcuts that apply for the Microsoft 
Excel program. For example, press the 
Tab key to complete a cell entry and 
select the next cell to the right. Press 
Shift+Tab to complete a cell entry and 
select the previous cell to the left. Use 
Arrow keys to move one cell left, right, 
up, or down. Press Home key to move to 
the beginning of the line.  

Edit cell contents You can use many of the keyboard 
shortcuts that apply for the Microsoft 
Excel program. For example, press the 
F2 key to edit the active cell and put the 
insertion point at the end of the cell. Use 
BACKSPACE to Edit the active cell and 
then clear it, or delete the preceding 
character in the active cell as you edit 
cell contents. Press ESC to cancel a cell 
entry. 

Contents may be in the form of typical 
Windows style text box, check box, or 
combo box. 
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Inserting, deleting, or appending rows 
The following procedure assumes that the PDE has been launched. You can only invoke 
these functions on tabs that allow edits. The following tabs allow edits. 

• Form Layout 

• Value CDPs 

• Symbol Attribute 

• Parameter References 
 

Step Action 

1 Click the tab you want to edit. 

2 • If you want to delete a row, go to Step 3.  

• If you want to insert a row, go to Step 5.  

• If you want to append a row, go to Step 6.  

3 Click in row header to select (highlight) the entire row you want to delete. You 
can use Shift+Click or Ctrl+Click to select multiple rows for deletion.  

4 Right-click the selected row(s) and select Delete from the shortcut menu or, 
just press the Delete key. You will be prompted to confirm multiple row 
deletions. 

5 Click anywhere in the row you want to insert a row above and press the Insert 
key. Or, right-click anywhere in the row you want to insert a row above and 
select Insert from the shortcut menu. You can use Shift+Click or Ctrl+Click to 
select multiple rows for insertion above the selected rows. 

6 To append a row to the end of the list, right-click anywhere in an existing row 
and select Append row from the shortcut menu. 

 

 
TIP 

Appending can also be accomplished by scrolling via the down arrow at the 
end of the rows. Rows will be added as you scroll down. 
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Using copy and paste functions 
You can use the typical keyboard shortcuts of Ctrl+C, and Ctrl+V to copy and paste cell 
data on tabs that permit edits. You can also select these functions through the right-click 
shortcut menu. 

Saving block definitions 
The following consideration should be observed when saving block definitions: 

• Modifications to the block type definition in PDE enables the Save button in the tool 
bar and the File menu 

To save PDE edits, click on Save from the File menu selections or on the Save button in 
the tool bar if you are saving a Fieldbus or CDB block. If you are saving a CAB block, 
saves are performed from the File menu Save All selection of the Visual Studio .NET 
IDE. 

 

 
TIP 

Clicking on the Save button or selecting the menu item File->Save PDE Data 
will save the PDE data to a block type definition file.  See Launching PDE 
under Launching and Closing PDE for more details on saving the PDE data. 

You will be prompted to Save any unsaved edits upon closing the PDE. See Launching 
PDE under Launching and Closing PDE. 

Save As block definition 

The following procedure assumes the PDE has been launched and a parameter is being 
edited and there is a need to create a new block definition. The following procedure 
applies to CAB and CDB blocks only. 

 
Step Action 

1 

 

On the File menu, click Save As... 

If you are saving a CAB block, saves are performed from the File menu Save 
All selection of the Visual Studio  NET IDE 

2 In the open Block Type text box, key in the desired name for you’re new block 
type that is unique. Press the Enter key. 

The new block name is displayed in the Control Builder library tree, and the 
current editing session switched to the newly created block definition. 
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Reviewing general block type functions 
Inserting, deleting, renaming, and appending tabs 

 

The following procedure assumes that the PDE has been launched. You can only invoke 
these functions on the Form Layout tab. 

 
Step Action 

1 Click the Form Layout tab.  

2 If you want to insert a tab, go to Step 3.  

If you want to delete a tab, go to Step 7. 

If you want to rename a tab, go to Step 10.  

If you want to append a tab, go to Step 14 

3 

 

Click the tab that you want the new tab inserted before. 

Remember that the Alarm tab on the Fieldbus block, the Main tab on the CDB 
block type, and the Main, Alarms, and Source tabs on the CAB block, are 
read only and you cannot insert a tab before them. 

4 On the Options button, click the arrow and select Tabs->Insert. Or, just right-
click the tab and select Tabs->Insert. 

5 In Tab Name dialog, key in desired name for the new tab in the Enter new tab 
name box. Click the OK button. 

6 New tab is inserted before the selected tab. 

7 Click the tab that you want to delete. 

8 On the Options button, click the arrow and select Tabs->Delete. Or, just right-
click the tab and select Tabs->Delete. 

9 Click the Yes button in the PDE dialog to acknowledge the action and initiate 
the tab deletion. 



Parameter Definition Editor Basics 
Reviewing the group box 

R300   Parameter Definition Editor Reference 75 
03/06 Honeywell 

Step Action 

10 Click the tab that you want to rename. 

11 On the Options button, click the arrow and select Tabs->Rename. Or, just 
right-click the tab and select Tabs->Rename. 

12 In Group Name dialog, key in desired new name for the tab in the Enter new 
group name box. Click the OK button. 

13 The new name now appears on the tab.  

14 On the Options button, click the arrow and select Tabs->Append. Or, just 
right-click the tab and select Tabs->Append. 

15 Enter the name of the new tab. 

16 Click OK 

Reviewing the group box 
 

 
TIP 

You can use the Group function to group similar parameter attributes to show 
logical parameter relationships on the block configuration form in Control Builder. 

 
Considerations 

• You can place Parameters on the left or right side of the tab. If the parameter is to be 
placed on the left side of the tab, enter the parameter name in the Left field name 
column. If it is to be placed on the right side, enter the parameter name in the Right 
field name column. 

• You can group and ungroup selected parameters.  

• The right group box is dependent on the definition of the left group box. The right 
group box cannot exist without a left group box. 

• The blank rows in the group do not have any effect on the layout. 

• The left group name is mandatory, if any parameters are defined in the left group 

• The right group name is mandatory, if any parameters are defined in the right group 

• You cannot have a parameter in the right group box without having parameters in the 
left group box. 
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• The height of the group box depends on the number of parameters in the left group box. 

• Rows can be inserted using INS key and can be deleted using DEL key. 
Alternatively Right click menu is also available for inserting and deleting the row. 

• Parameters can be grouped/ungrouped using the group/ungroup functionality. 

• Tabs can be added, deleted and renamed by using the Menu item from the Options 
tool bar. 

• Parameters can be used only once across all the tabs defined in the form layout. 
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Creating the left group box 
 

Step Action 

1 Select the parameters that are to be grouped in the form layout grid. The 
selected parameters that are to be grouped should be in sequence 

 

2 From the options tab select the menu item Parameters->Group. Alternatively 
right click menu will also provide an option to group parameters under the 
menu item Parameters->Group. 

 

3 Once the menu item is selected all the selected parameters will be grouped 
and shown inside a thick black rectangle around the selected parameters 

 

• The left field name cell in the first row of the group is for entering the name of the 
left group.  

• Parameters can be added within the group box by inserting a new row using INS key 
and entering the parameter name in the left field name. Alternatively from the right 
click menu rows can be added. 

• Parameter can be deleted using DEL key by selecting the complete row. 
Alternatively from the right click menu rows can be deleted. 

The above defined parameter group will be shown as below in the Configure Parameters 
dialog in Control Builder 
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Creating the right group box 
The following the left group box exists. 

On the Form Layout grid, enter the parameters for the right field name in the right group 
box. The active area of the form is enclosed in a thick black rectangle. 

Enter the right group box name at the top of the black rectangle. 
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Configuration Form with grouped parameters 
 

 
TIP 

The parameter Auto Pump #1 was created as an arrayed parameter with an 
index of 5.  

 

Example Tab with Parameters Grouped 
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Ungrouping parameters in a group box 
You can use the Ungroup function to remove a group box. You can only invoke these 
functions on the Form Layout tab. The following procedure is for example purposes only 
to show how the Ungroup function may be used. 

 
Step Action 

1 Highlight the group that you want to delete by left clicking on the first row and 
dragging down until the entire group is highlighted, including the group name. 
In this example, the East Building group is highlighted. 
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Step Action 

2 Right-click any where on the group and select Parameters->Ungroup. The 
group box and group title, East Building, will be removed. 
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Step Action 

3 When an instance of this block is added to a project, the resulting edits of the 
group box tab will appear as follows: 

 

Notice that the East Building group has been removed. 
 

Reviewing the grid 
Using the grid 

The grid is an option available for CAB and CDB block types. Grids are used to show a group of 
parameters where each parameter is shown as one of the columns of the grid and each parameter 
value is shown in the grid rows.
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Considerations 
• The grid name is mandatory and must be entered in the left field name. 

• The number of rows visible should be between 1 and 99. 

• There is no right field name for the grid. 

• Grid only supports array Custom Data Parameters. Grid does not support scalar 
CDPs or Parameter References. 

• Only arrayed parameters are allowed in the grid. 

• Parameter references are not allowed in the grid. 

Creating a grid 
Follow the steps in the following table to create a grid. 

 



Parameter Definition Editor Basics 
Reviewing the grid 

84   Parameter Definition Editor Reference  R300 
 Honeywell 03/06 

Step Action 

1 Select the parameters that are to be defined within the grid in the Form Layout 
grid as shown below. The selected parameters must be in sequence. 

 

2 From the drop-down Options tab, select parameters->Define Grid. Right clicking 
on the highlighted parameters will also provide a drop-down menu where 
Parameters->Define Grid can be selected. 
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Step Action 

3 The number of the lines for the grid should be entered in the Right field name 
column. This is the maximum number of rows that will be shown at a time in the 
grid on the Configuration Form. If there are more rows than visible lines, then a 
scroll bar will be shown on the grid. 

The grid name can be entered in the first row of the grid under the left field name. 
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The resulting Configuration Form for this grid would look like the example below. 

 
 

 
TIP 

• Parameters can be added within the grid box by inserting a new row 
using the INS key and entering the parameter name or by right clicking 
and inserting a row. 

• Parameters can be deleted by using the DEL key or by right clicking and 
deleting the row. 

 
When 2 dimension arrayed parameter of size 5x5 is added to the grid, it is shown as 
below in the configuration form. Note that the first column shows the 2-dimension array 
index 
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When the grid is formed with the combination of 2 dimension arrayed parameter (5x5 
size) and the 1 dimension arrayed parameter (10 elements), the grid is shown as below in 
the configuration form. Note that the first column displays just the row numbers. 

 

 
TIP 

If the grid has more than one arrayed parameter, then the first column will 
show just the row number. 

 
 

 

Deleting a grid 
Follow the steps in the following table to delete a grid. 

 
Step Action 

1 Select the complete grid that you want to delete. 

2 From the drop-down Options tab, select parameters->Remove Grid. Right 
clicking on the highlighted parameters will also provide a drop-down menu 
where Parameters->Remove Grid can be selected. 
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Advanced editing options 
Using advanced editing grid bitstrings 

You can use the Advanced editing grid to edit the default values for parameters with a 
data type of BITSTRING on the Standard Parameters or Vendor Parameters tab. 

Follow the procedure in the next table to edit BITSTRING values 
 

Step Action 

1 Click either the Standard Parameter or Vendor Parameter  tabs. 

2 Locate the parameter with the BITSTRING value you want to change. For 
example, the MODE PERMITTED parameter for an AI block in a Honeywell 
ST3000 device. 

3 Scroll to the Default value column and click the row for the MODE 
PERMITTED parameter. Click the arrow button in the row to open the 
Bitstring values for parameter dialog box. Or, just key in the hexadecimal 
value in the cell directly and skip using the dialog box.  

4 In the Bit values column, click the check box to select or clear a value as 
applicable. Select the check box, if the bit is to be set to that value.  

5 Click the OK button to save your edits and close the dialog.  

6 This completes the procedure. Any BITSTRING value edits are not active 
until the PDE is closed and all edits are saved. There is no validation whether 
the proper bit is set by directly entering the value. PDE validates only for the 
size of the BITSTRING 

 

 
ATTENTION 

The Advanced editing grid bitstrings is for use with Fieldbus block types only. 
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Considerations 

• The first column in the Advanced editing grid dialog shows the bit that will be set, if 
the check box for the value is selected in the second (Bit values) column  

• You set the bit value by selecting or clearing the check box in the Bit values column.  

• The parameter must have a data type of bitstring for the Advanced editing grid 
dialog to be shown. 

• Any BITSTRING value edits are not active until the PDE is closed and all edits are saved. 

• There is no validation whether the proper bit is set by directly entering the value. 
PDE validates only for the size of the BITSTRING. 

Using advanced editing grid for arrays 
The arrayed parameter default value can be edited using the advanced array-editing grid. 
Based on the size of the array, number of rows, and number of columns will be shown in 
the grid. The values can be set to the individual elements of the array. 

The single dimension array will be shown with one column. The number of rows 
corresponds to the first dimension of the array. 
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Advanced editing grid – Single dimension array 
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Considerations 

• The editing of the cell depends on the data type of the parameter 

• The value entered will be validated for its range with the min and max value of the 
parameter. 

•  

• Copy/Paste operation can be performed in the grid using the right click menu and 
accelerator keys Ctrl+C and Ctrl+V respectively. 

The 2-dimension array will be shown as below. The number of columns corresponds to 
the second dimension of the array. The number of rows corresponds to the first 
dimension of the array. 
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Advanced editing grid – Two dimension array of size 5x2 
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Advanced editing grid – Two dimension array of size 5x4 
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Advanced editing grid – Two dimension array of size 5x5 with negative 
indices 
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Procedure for using advanced editing grid for arrays 
 

Step Action 

1 Click the Vendor Parameters tab. 

2 Locate the parameter with dimension array value you want to change. For 
example, the USER_CHAR parameter for an ADV_POS_BASIC block in a 
Fisher_Controls DVC 5000 device. 

3 Scroll to the Default value column and click the row for the USER_CHAR 
parameter. Click the arrow button in the row to open the Default value for 
parameter “USER_CHAR” dialog box. 

4 In the 1 column, key in the desired value for each element as applicable.  

5 Click the OK button to save your edits and close the dialog.  
  

 
ATTENTION 

Any array value edits are not active until the PDE is closed and all edits are 
saved. 
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Reviewing general parameter functions 
Using cut/copy/paste for custom parameters 

The custom parameters tab will not show all the attributes of the parameters. There are 
some attributes, which are internally managed. Using the Manage view feature can hide 
attributes. In such scenarios the need arises to copy the whole parameter definition 
irrespective of whether attribute is internally managed or hidden through views. The 
cut/copy/paste parameters will allow copying the whole parameter definition and pasting 
the definition as a new parameter. This feature will also work across PDE, meaning in 
one instance of PDE the parameters can be copied and pasted in another instance of PDE. 

Cut Parameters 
The following consideration should be observed when cutting parameters: 

• A complete row should be selected to cut parameters. 

The following is used to cut parameters: 
 

Step Action 

1 Click a parameter on active tab and right-click causing the right-click  
menu to appear. 

2 On the right-click menu, click Cut parameters. This removes the parameter 
definition and copies it to the clipboard. 

 
Copy Parameters 

The following considerations should be observed when copying parameters: 

• Copy parameter menu is enabled only if any of the selected rows has a parameter 
definition. 

• Multiple rows can be selected to copy multiple parameters. 

The following procedure is used to copy parameters: 
 

Step Action 

1 Click a parameter on active tab and right-click causing the right-click 
 menu to appear. 

2 On the right-click menu, click Copy parameters. This copies the 
selected parameter. 
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Paste Parameters 
The following considerations should be observed when pasting parameters: 

• The paste parameter menu is enabled only if there are any parameters available in 
the clipboard for pasting. 

• The pasting starts from the row where the menu was right-clicked. 

• Pasting on the row, which has defined parameter, overwrites the parameter 
attributes. 

• A new parameter name is generated if the parameter name already exists. 

The following procedure is used to paste parameters: 
 

Step Action 

1 Click a parameter on active tab and right-click causing the right-click menu to 
appear. 

2 On the right-click menu, click Paste parameters. This pastes the previously 
copied parameter in the selected row. 
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Automatic form layout 
Generating automatic form layouts 

The automatic form layout generation is the feature that generates the form layout from the order 
of the parameters defined. 

 Considerations for CDB and CAB 

• Any update to the parameters in the “Value CDPs” main tab will be reflected in the 
“Value CDPs” tab of the Form Layout. 

• The order of the parameter in the “Value CDPs” main tab and the “Value CDPs” tab of 
the Form Layout will be same. 

• The GUI control used for the parameter will be decided while populating the data to 
ERDB based on the data type of the parameter. 

• In the case where the form layout is disturbed, the form layout can be regenerated from 
the options menu, Regenerate Layout. This will create a layout by placing all the custom 
parameters in the Left field name of the form layout. 

 

Considerations CDB Specific 
This feature is only available to: 

• the “Value CDPs” tab on the form layout - CDB 

The “Value CDPs” tab in Form Layout “Value CDPs” is designated as the tab in which the Custom 
parameters will be shown. Any custom parameter added in the “Value CDPs” main tab, would also be 
added to the “Value CDPs” tab of the Form Layout tab. If the order of the parameters in the form 
layout tab is altered then the automatic form layout generation will work minimally. 

Any difference in the order of the parameters in the “Value CDPs” main tab and the 2nd tab 
of the form layout will cause the automatic form layout generation to work minimally. 

The following should be considered. 
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• The parameter will be added to the end of the “Value CDPs” tab if the appropriate 
place for the new parameter could not be identified. 

• Even if the above case fails then the parameter will be added to the 1st tab of the 
Form Layout  

• Failure in both the above cases will generate an error and the parameter should be 
added manually 

Considerations CAB specific 

This feature is only available to: 

• the Custom parameters and Parameter references tab. 

• The “Value CDPs” and “Parameter References” tabs in the Form Layout are 
designated as the tabs in which the Custom and Parameter Reference parameters will 
be shown respectively. Any custom parameter added in the “Value CDPs” main tab, 
would also be added to the “Value CDPs” tab of the Form Layout tab. Any parameter 
reference added in the “Parameter References” main tab, would also be added to the 
“Parameter References” tab of the Form Layout tab. If the order of the parameters in 
the Form Layout tab is altered, then the automatic form layout generation will work 
minimally. 

• Any update to the parameters in the “Parameter References” main tab will be 
reflected in the “Parameter References” tab of the Form Layout. 

• The order of the parameters in the “Parameter References” main tab and the 
“Parameter References” tab of the Form Layout will be same. 

• Any difference in the order of the parameters in the “Value CDPs” / “Parameter 
References” main tab and the  “Value CDPs” / “Parameter References” tab of the Form 
Layout respectively, will cause the automatic form layout generation to work minimally. 

• The following should be considered. 

− The parameter will be added to the end of the “Value CDPs” / “Parameter 
References” tab based on the parameter category, if the appropriate place for the 
new parameter could not be identified. 

− Even if the above case fails then the parameter will be added to the 1st tab of the 
form layout. 

− Failure in both the above cases will generate an error and the parameter should 
be added manually. 
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Reviewing PDE Views 
You can customize the views of the Standard Parameters, Vendor Parameters, and Value CDPs 
tabs in PDE to show only the parameter attributes that you select through view configuration. 

Reviewing PDE views for CAB and CDB 
The view is an option in PDE to switch ON/OFF the columns of the grid. The view 
information will be stored with respect to the block type and will be applied only to the 
Custom parameter grid (Value CDPs). The view information is carried along with the block 
type. If the block type opened by PDE has a view defined, then the block type view will be 
applied to the Custom parameter grid otherwise; the system default view will be applied. 

Considerations 
• You configure the parameter attributes through a check box selection in the 

Parameter Attributes list box. 

• All the system default parameter attributes will be listed in the parameter attributes list. 

• All the mandatory parameter attributes are shaded, since they are not available for 
configuration and they will always be selected. 

• The grayed parameter attributes will always be selected and cannot be switched OFF. 

• The parameter attributes list will have a check box to indicate the attributes to be 
shown in the grid. The checked items will be shown and un-checked items will not be 
shown in the grid. 

• Clicking on the OK button will save the view information in memory with the block 
type definition. 

• Only after the block type definition is written to disk, will the view information be 
physically written along with the block type definition. 

• Clicking on the Cancel button will discard all the changes. 
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Launching Configure PDE views dialog for CAB 
The PDE window should be opened to invoke the Configure PDE views dialog. 

Selecting the menu item View->Configure PDE View… will invoke the Configure PDE 
views dialog. 

 

PDE Views Dialog 
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Launching Configure PDE views dialog for CDB 
The PDE window should be opened to invoke the Configure PDE views dialog. 

Selecting the menu item View->Configure PDE Views will invoke the Configure PDE 
views dialog. 

 

PDE Views Dialog 



Reviewing PDE Views 
Reviewing PDE views for CAB and CDB 

104   Parameter Definition Editor Reference  R300 
 Honeywell 03/06 

 
 



Reviewing PDE Views 
Reviewing Manage PDE views for Fieldbus 

R300   Parameter Definition Editor Reference 105 
03/06 Honeywell 

Reviewing Manage PDE views for Fieldbus 
Views are an option in PDE to switch ON/OFF the columns of the grid. The view 
information is stored with respect to the user and is applied only to the Standard 
Parameters grid, and Vendor Parameters grid. Views can be created and modified and 
applied from this Manage PDE views dialog for FieldBus devices only. 

Considerations 

• All the defined views of the current logged in user will be included in the Views list 
on Manage PDE Views dialog. 

• The Default View field, shown just above the Views list, identifies the name of the 
current default view. 

• The Current View field identifies the name of the current view being used.  

• The Views list box is a single selection list. 

• The Parameter Attributes list box is a multiple-selection list and it identifies the 
parameter attributes configured for the view selected in the Views list. 

• You can select a view in the View list to check its configuration in the Parameter 
Attributes list. 

• The System view is factory configured and you cannot modify or delete it. It will 
show all the parameter attributes. 

• You must assign a unique name to each view you create. 

• The Current view is shown just above the Parameter attributes list. 

• In the Views list: 

− the views are displayed/defined by the current logged user. 

− the Current view is selected. 

− only one view can be selected at a time. 
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• The Parameter attributes list box:  

− is multi-selection list. 

− checked items are shown and un-checked items are not shown in the grid. 

− mandatory parameter attributes are grayed (always selected and cannot be 
switched OFF). 

• Selecting a view in the Views list will show the parameters that are switched 
ON/OFF for the view in the parameters attributes list. 

• Clicking on: 

− the OK button prompts for a save if any modifications were done. 

− the Cancel button discards all the changes. 

Launching Manage PDE Views dialog 
The PDE window should be opened to invoke the manage views dialog. 

Selecting the menu item View->Configure PDE Views will invoke the Manage PDE 
Views dialog. 
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Creating new Manage view 
Use the following procedure to add a new view. 

 
Step Action 

1 Click on New 

2 Enter a unique name for the new view 

3 Select the parameters from the Parameter Attributes-System list to be shown 
for this view. 

4 Select OK 
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Deleting Manage view 
Use the following procedure to delete a view. 

 
Step Action 

1 Click on the view that you want to delete 

2 Select Delete 
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Setting view as default view 
Use the following procedure to set a view as the default view. 

 
Step Action 

1 Click on the view that you want to set as the Default view. 

2 Select Set As Default. 

3 Select OK 
 

 

Setting view as current view 
Use the following procedure to set a view to the current view. 

 
Step Action 

1 Click on the view that you want to set as the Current view. 

2 Select Set As Current. 

3 Select OK 
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Launching and Closing PDE 

Overview 
Launching PDE 

Control Builder is running and you have logged on with engineering access level or 
higher, if you want to edit parameters. If you log on with Operator access level, you will 
be granted read-only access. 

 
Step Action 

1 On the Library tab, click the plus sign for the device named folder. 

2 Click the plus sign for the device icon to expose its blocks. 

3 Double-click the desired device block. 

4 The Parameter Definition Editor for the selected block type opens in the 
Control Drawing area of Control Builder. 

  In the example below, a Fieldbus device has been selected from the library. 
The previous steps are the same if a CAB or CDB device had been selected. 
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Closing/re-opening PDE in VS.NET IDE when using CAB 
The PDE window can be closed at any time within the Visual Studio .NET IDE. This can 
be done using the menu option File->Close. The PDE window should be the active 
window when using this menu item. 

 

 

If any data is to be saved before closing the PDE window, a message will be displayed to 
save the PDE data changes. 
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The closed PDE window can be opened any time using the menu option File->Open-
>Parameter Definition Editor. 

 

This will re-open the PDE with the saved data. 
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Error Messages 

Overview 
The error messages that are specific to the PDE will be stored internal to PDE and 
displayed by PDE. The error messages that are generated by the PDE are listed below. 
The messages are grouped based on the context in which the errors are generated. 

Editing parameter names 
The following table lists possible error messages and their description when editing 
parameter names. 

 
Error Message Description 

"Parameter name already exist. Please 
enter new parameter name." 

The message shown when the new 
parameter entered is not unique 

"Parameter name cannot be empty. 
Please enter the parameter name" 

Message shown when editing parameter 
name results in an empty string 

"Invalid character in the parameter 
name." 

Message shown when any invalid 
characters are entered for the parameter 
name 

"Length of the Parameter name exceeds 
the maximum length" 

Message shown when the length of the 
parameter name exceeds the specified 
length 

"First character in the Parameter name 
should be alphabetic" 

Message shown when the first character 
of the parameter is invalid 
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Editing cells 
The following table lists possible error messages and their description when editing cells. 

 
Error Message Description 

"Invalid value entered in the cell. Please 
enter valid value." 

The value entered is the cell is invalid. 
The invalid value could be non numeric 
characters in the numeric cell etc. 

"The data type for the parameter is not 
defined. Cannot edit the cell" 

When a data type of the parameter is not 
defined and a cell is being edited that 
depends on the data type, the message 
is shown. This message is specific to the 
Default value, Min/Max value 

 

Editing array values 
The following table lists possible error messages and their description when editing array 
values. 

 
Error Message Description 

"Array value cannot be blank in the cell 
%1. Please enter the array value." 

The message shown in the array value 
editing grid when any intermediate array 
value is left blank  

"Invalid array size. Array size cannot be 
less than zero or empty" 

Message shown when array size entered 
is invalid 

"First dimension of array should be 
defined to specify second dimension." 

Message shown when the second 
dimension is being edited without 
specifying the first dimension 

“Invalid array value syntax. Cannot set 
the array value” 

Message shown when the syntax of the 
array definition is invalid. This message 
is applicable during paste operation 
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Validating ranges 
The following table lists possible error messages and their description when validating 
ranges. 

 
Error Message Description 

"The value entered is less than the 
minimum value." 

Message shown when the default value 
of the parameter is less than the 
minimum value of the parameter. 

"The value entered is greater than the 
maximum value." 

Message shown when the default value 
of the parameter is greater than the 
maximum value of the parameter. 

"The minimum value cannot be greater 
than maximum value." 

Message shown when the minimum 
value of the parameter is greater than 
maximum value 

"The maximum value cannot be less than 
the minimum value." 

Message shown when the maximum 
value of the parameter is less than 
minimum value 

"Invalid string length. The length of the 
string cannot be zero" 

Message shown when the length of the 
string is entered as 0 

"The Default Value(s) is not in range due 
to change in the cell value. Cannot 
change the cell value" 

Message shown when the default value 
of the parameter does not fall in the 
range of min/max due to change in the 
value of min/max value. 

"The value entered is greater than the 
maximum length allowed." 

The default value entered for the string 
data type is greater than the size of the 
string specified. 

"The value does not fit into the size of the 
data type" 

Message shown when the value entered 
in the cell does not fit the size of the data 
type. 

"Invalid parameter for parameter 
reference. The parameter does not exist!” 

Message shown when the Min/Max/Unit 
parameter reference does not validate to 
any parameter. This message is specific 
to FF 
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"The data size of the field is exceeding 
the maximum length of the field. The 
maximum length of the field is 255 
characters. 

Message shown when the parameter 
description field exceeds the maximum 
length of 255 characters. 

“One of the array value is invalid or does 
not fit into the size of the data type” 

Message shown when multiple array 
values are being pasted/entered in the 
cell that resulted in an invalid value. 

“The length of the string is greater than 
the maximum length allowed.” 

Message shown when the length of the 
string is greater than the length specified 
in the size attribute 

 

Editing symbol attributes tab 
The following table lists possible error messages and their description when editing 
symbol attributes tab. 

 
Error Message Description 

"The symbol attribute name is not 
defined. Cannot edit the cell" 

Message shown when the symbol 
attribute in the parameter name column 
is not defined and the pins are being 
assigned 

"The order is not unique in the column. 
Please enter the unique value." 

Message shown when the pin values 
entered in the symbol attributes tab is not 
unique. 

The pin exposure permission of 
parameter "%1" does not allow to 
configure "%2" pin. 

Message shown when the parameter 
entered for specifying symbol attribute 
does not have a valid pin exposure 
permission 

"Parameter is already defined in the row 
%1" 

Message shown when the same 
parameter is been used more than once 
in the symbol attribute. 

"Invalid syntax in parameter name" Message shown when the lexical syntax 
of the parameter name is invalid. E.g. 
using different character to specify the 
array index, etc. 

"Invalid array index specified in the 
parameter name" 

Message shown when the arrayed 
parameter is being referred, the array 
index is invalid 
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"The array subscript is out of range." Message shown when the arrayed 
parameter subscript is out of range 

"Index for the parameter is invalid. The 
parameter is not an array." 

Message shown when the array index is 
specified for the non-arrayed parameter 

"Parameter is defined as array. But array 
subscript is not specified" 

Message shown when the array index is 
not specified for the arrayed parameter 

“Invalid parameter "%1". Please select 
the valid parameter.” 

Message shown when an invalid 
parameter name is picked in the 
Parameter Picker dialog 

 

Editing form layouts 
The following table lists possible error messages and their description when editing form 
layouts. 

 
Error Message Description 

"Row [%1]: Invalid Parameter name 
entered in the row " 

Message shown when the parameter 
name for the form layout is invalid 

"Row [%1]: Group should have at least 1 
parameter. Blank groups are not allowed 
!" 

Message shown when the group box 
does not have any parameter defined 

"Row [%1]: Grid should have at least 1 
column. Blank grids are not allowed !" 

Message shown when the grid does not 
have any parameter associated with it 

"Row [%1]: The parameter in the row is 
already used once. Cannot use the same 
parameter in multiple tabs." 

This message is shown when there are 
multiple instances of the same parameter 
in the form layout 

"Row [%1]: Parameter category ""%2"" is 
not allowed in the form layout !" 

Message shown when parameter other 
than custom/standard/vendor parameter 
category is used in the form layout 

"Row [%1]: Invalid number of lines visible 
specified in the row. The value should be 
> 0" 

Message shown when the number of 
visible lines for the grid is invalid 

“Delete/Copy/Cut/Paste of MODE group 
is not allowed. This is a mandatory 
parameter group on the form layout” 

Message shown when the 
parameter/group of the MODE parameter 
is being deleted This message is specific 
to field bus 
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“Form layout tab name cannot be empty.” Message shown when the tab name 
entered is empty 

“The paste operation from the current 
row will likely overwrite the MODE group. 
This is a mandatory parameter group on 
the form layout and cannot be 
overwritten.” 

Message shown when the paste operation 
is likely to overwrite the MODE group. This 
message is specific to field bus. 

“New row cannot be added to the MODE 
group. The MODE group is fixed.” 

Message shown when a new row is 
being inserted into the MODE group. This 
message is specific to FieldBus 

“Row[%1] : The left group name is 
mandatory” 

Message shown when the left group 
name is not specified 

“Row[%1] : The right group name is 
mandatory” 

Message shown when the right group 
name is not specified 

“Row[%1] : The grid name is mandatory” Message shown when the grid name is 
not specified 

“Row[%1] : Right field name is not 
allowed without left field name” 

Message shown when a row has only 
right field defined with a left field. 

“Row[%1] : Right field name cannot be 
empty in the row” 

Message shown when a bottom row is 
left blank in the right field. 

“The tab name "%1" is already used. 
Please enter the new tab name” 

Message shown when a new tab name 
entered already exist. The tab names 
should be unique. 

“Cannot create/move tab before "%s" 
tab. "%s" tab position is fixed on form 
layout.” 

This message is shown when a user tries 
to create a new tab before the read only 
tab. With FF, it is the “Alarm” tab and with 
CAB/CDB, it is the “Main” tab. Since the 
read only tab position is fixed, no tabs 
can be created before the tab. 

“Cannot DELETE any tab before "%s" 
tab. "%s" tab position is fixed on form 
layout.”. 

This message is shown when auser tries 
to delete a tab before any read only tab  
With FF, it is the “Alarm” tab and with 
CAB/CDB, it is the “Main” tab. Since read 
only tab position is fixed no tabs can be 
deleted before the tab. 
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“Cannot RENAME "%s" tab. "%s" tab is 
mandatory tab on form layout.”. 

This message is shown when a user tries 
to rename the read only tab. With FF, it is 
the “Alarm” tab and with CAB/CDB, it is 
the “Main” tab. Since the read only tab 
position and name is fixed the tab cannot 
be renamed. 

“Cannot DELETE "%s" tab. "%s" tab is 
mandatory tab on form layout.”. 

This message is shown when a user tries 
to delete the read only tab With FF, it is 
the “Alarm” tab and with CAB/CDB, it is 
the “Main” tab. Since the read only tab 
position and name is fixed, the tab 
cannot be deleted 

“Cannot MOVE "%1" tab. "%1" tab 
position is fixed on form layout.”. 

This message is shown when the user 
tries to drag and drop the read only tab 
With FF, it is the “Alarm” tab and with 
CAB/CDB, it is the “Main” tab. Since the 
read only tab position and name is fixed, 
the tab cannot be deleted. 

“Automatic form layout generation failed. 
The parameter "%1" was not added to 
the form layout. The parameter has to be 
added manually to the form layout.”. 

Message shown when the newly created 
parameter on the “Value 
CDPs”/Parameter References tab was 
not added on the form layout. The user 
changing the parameter order could 
cause this. 

"Row [%s] : Parameter ""%s"" with 
category ""%s"" is not allowed inside 
grid". 

Message shown when the parameter, 
which belongs to category that is not 
allowed on the grid, is added to the grid. 

"Row [%1] : Non arrayed parameter 
""%2"" is not allowed inside grid". 

Message shown when the non arrayed 
parameter is added as a column of the 
grid. 

 

Validating manage views 
The following table lists possible error messages and their description when validating 
manage views. 

 
Error Message Description 

"%s - The view name already exists, 
please enter different view name!" 

Message shown when the duplicate view 
name is entered. 
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"No tabs are configured to be associated 
with views. Cannot configure views" 

Message shown when none of the tab is 
configured to show Manage views and 
the configure views dialog is invoked by 
the container 

"The active tab does not support views. 
Only the following tabs support views." 

Message shown when the tab configured 
for Manage views is not active and the 
configure views dialog is invoked 

 

Saving PDE data 
The following table lists possible error messages and their description when saving PDE 
data. 

 
Error Message Description 

"The parameter attribute ""%1"" is 
mandatory in the row ""%2""" 

Message shown when one of the 
mandatory parameter attributes is not 
specified. This message comes up while 
saving 

“Cannot save file. No file is opened to 
save” 

Message shown when no file is opened 
and the Save method of PDE is called 

“Error writing the XML file to the disk” Message shown when any Error 
occurred while saving the .DEF.XML file. 
More information about the error will be 
logged in the EHI error log file 
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